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BAB II  

DASAR TEORI 

 

2.1 Tinjauan Pustaka 

Pada bab ini akan dibahas beberapa kajian pustaka dan penelitian 

terdahulu yang berkaitan dengan pengembangan sistem pembersih panel 

surya otomatis berbasis mikrokontroler ESP32. Tinjauan pustaka disusun 

untuk memperkuat lPenggunasan teoritis serta memahami posisi dan 

urgensi penelitian yang dilakukan. Selain itu, pembahasan ini juga 

memberikan gambaran mengenai teknologi yang telah digunakan dalam 

penelitian sebelumnya, serta potensi inovasi dan pengembangan yang 

dapat diterapkan pada alat yang dirancang. 

Beberapa aspek utama yang dibahas meliputi teknologi panel surya, 

pengaruh akumulasi debu terhadap efisiensi panel, prinsip kerja sensor 

debu PM2.5, sistem penjadwalan berbasis RTC, kontrol aktuator seperti 

motor dan pompa, serta integrasi data logger berbasis Internet of Things 

(IoT). Dengan mengkaji literatur yang relevan, penelitian ini dapat 

diarahkan secara lebih terstruktur dan berdasarkan pendekatan ilmiah yang 

tepat. 

1) Penelitian dalam [1] mengembangkan sistem pembersih panel surya 

otomatis menggunakan wiper yang digerakkan oleh motor servo, 

serta dilengkapi sensor debu GP2Y1010AU0F dan modul RTC 

DS3231 sebagai pengatur waktu. Sistem ini dikendalikan oleh 

mikrokontroler Arduino Uno dan bekerja berdasarkan dua 

parameter, yaitu waktu terjadwal (pukul 06.00 dan 18.00 WIB) serta 

konsentrasi debu dengan ambang batas 0,04 mg/m³. Alat tersebut 

telah terbukti mampu meningkatkan tegangan output panel surya 

setelah dilakukan pembersihan, baik berdasarkan jadwal maupun 

kadar debu. 
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Penelitian penulis memiliki kesamaan konsep dengan alat yang 

penulis kembangkan, yaitu sama-sama menggunakan prinsip 

otomatisasi berbasis sensor debu dan waktu, serta memanfaatkan 

wiper sebagai pembersih utama. Selain itu, kedua sistem sama-sama 

menggunakan sensor GP2Y1010AU0F dan RTC DS3231 dalam 

mendeteksi kondisi lingkungan dan mengatur waktu operasional 

alat. Hubungan antara kedua penelitian penulis terletak pada 

permasalahan yang diangkat, yaitu bagaimana mengatasi penurunan 

efisiensi panel surya akibat akumulasi debu secara otomatis, tanpa 

intervensi manual yang berisiko atau tidak efisien. 

Namun, terdapat beberapa perbedaan signifikan yang menjadi 

keunggulan dari penelitian penulis dibanding penelitian sebelumnya. 

Alat yang dikembangkan dalam penelitian penulis menggunakan 

mikrokontroler ESP32 sebagai pengendali utama, yang memiliki 

kelebihan dari sisi performa dan konektivitas karena dilengkapi WiFi 

untuk mendukung fitur data logger berbasis cloud. Selain itu, sistem 

ini tidak hanya mengPenggunalkan servo untuk pembersih wiper, 

tetapi juga mengintegrasikan pompa air dan sistem penyemprot 

kabut untuk meningkatkan efektivitas pembersihan. Nilai ambang 

batas kebersihan pada alat ini juga mengacu pada stPenggunar 

nasional yang lebih relevan, yakni 55 µg/m³ (sesuai PP No. 22 Tahun 

2021) untuk parameter PM2.5, dibandingkan dengan ambang batas 

0,04 mg/m³ yang digunakan dalam penelitian sebelumnya tanpa 

dasar baku mutu nasional. 

Dengan demikian, sistem yang dirancang dalam penelitian penulis 

dapat dikatakan lebih unggul dan modern, karena tidak hanya 

bekerja berdasarkan sensor dan waktu, tetapi juga mendukung 

pemantauan jarak jauh melalui cloud, memiliki akurasi pengambilan 

keputusan yang lebih tepat, dan sesuai dengan regulasi baku mutu 

lingkungan yang berlaku. 

 



9 
 

 

 

2) Penelitian dalam [2] mengusung sistem pembersih otomatis panel 

surya menggunakan mikrokontroler Arduino Uno yang 

dikombinasikan dengan modul RTC dan sensor hujan sebagai 

pemicu pembersihan. Mekanisme alat melibatkan motor DC untuk 

menggerakkan wiper dan pompa air untuk membasahi permukaan 

panel, serta dilengkapi dengan pengaturan waktu pembersihan secara 

reguler dan berdasarkan kondisi hujan. Sistem ini dirancang untuk 

mengurangi akumulasi debu dan kotoran yang dapat menurunkan 

efisiensi penyerapan cahaya matahari oleh panel surya. 

Penelitian penulis memiliki kesamaan dengan alat yang penulis 

kembangkan, terutama pada konsep dasar sistem pembersihan 

otomatis, penggunaan motor DC, dan pemanfaatan mikrokontroler 

sebagai pusat kendali. Hubungan antara kedua penelitian terletak 

pada upaya menciptakan alat yang mampu menjaga efisiensi panel 

surya tanpa campur tangan manual, yang sangat berguna untuk area 

yang sulit dijangkau atau memiliki intensitas debu tinggi. 

Namun, terdapat perbedaan signifikan yang menunjukkan 

keunggulan dari sistem yang penulis kembangkan. Alat ini 

menggunakan ESP32 sebagai mikrokontroler utama, yang memiliki 

konektivitas WiFi bawaan, sehingga memungkinkan integrasi 

dengan sistem cloud-based data logger untuk pemantauan data real-

time. Selain itu, alat penulis menggunakan parameter kebersihan 

berbasis PM2.5 yang diukur dengan sensor debu GP2Y1010AU0F, 

dan dibandingkan dengan stPenggunar nasional (PP No. 22 Tahun 

2021) sebagai dasar keputusan otomatis, bukan hanya waktu atau 

hujan. Proses pembersihan juga diatur lebih cermat menggunakan 

limit switch untuk mengontrol batas gerak, serta fitur penjadwalan 

otomatis pada pukul 04.00 dan 19.00 WIB. 

Dengan demikian, sistem yang dikembangkan oleh penulis dinilai 

lebih unggul dari sisi kecerdasan, efisiensi operasional, dan 

kemampuan pemantauan jarak jauh, menjadikannya lebih adaptif 



10 
 

 

 

untuk digunakan dalam skala luas dan lingkungan dengan tingkat 

debu yang bervariasi. 

3) Penelitian dalam [3]menyajikan kajian mendalam terhadap 

perkembangan riset dan produk komersial dalam sistem pembersih 

panel surya, baik dari aspek teknis maupun penerapan global. Artikel 

tersebut membedakan metode pembersihan menjadi dua kategori 

utama, yaitu manual dan otomatis. Pembersihan otomatis umumnya 

dilakukan oleh robot portabel atau sistem yang terpasang permanen 

di panel, menggunakan sikat, wiper, atau penyemprot air yang 

dikendalikan oleh mikrokontroler. Studi ini juga menampilkan 

berbagai alat komersial seperti robot pembersih ekskavator, sistem 

vacuum, dan alat pembersih dengan kuas otomatis yang tersedia di 

pasar internasional, menPenggunakan kemajuan signifikan dalam 

teknologi pembersih panel surya. 

Penelitian ini memiliki kesamaan dan keterkaitan erat dengan alat 

yang penulis kembangkan, yaitu sama-sama bertujuan untuk 

menjaga kebersihan panel surya secara otomatis guna 

mengoptimalkan produksi energi. Konsep penggunaan motor 

penggerak dan sistem penyemprotan air juga ditemukan dalam kedua 

pendekatan. Namun, alat yang dikembangkan oleh penulis 

menghadirkan inovasi lebih lanjut melalui integrasi sensor PM2.5 

sebagai parameter kebersihan berdasarkan data kualitas  mikro, serta 

sistem penjadwalan otomatis berbasis RTC. Selain itu, perangkat ini 

didukung oleh mikrokontroler ESP32 dengan konektivitas WiFi, 

yang memungkinkan integrasi cloud-based data logger untuk 

pemantauan dan pencatatan data dari jarak jauh. 

Berbeda dengan fokus jurnal tersebut yang lebih banyak menyoroti 

bentuk fisik dan varian alat dari sisi komersial dan mekanikal, sistem 

yang dirancang oleh penulis lebih menekankan pengambilan 

keputusan cerdas berbasis parameter lingkungan (PM2.5) dan waktu 

(RTC). Hal ini menjadikan alat penulis lebih unggul dalam aspek 
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efisiensi logika kerja, penghematan sumber daya, serta kesiapan 

untuk pengembangan skala luas dan pemantauan terintegrasi 

berbasis IoT. Dengan demikian, alat ini tidak hanya sebagai solusi 

teknis, tetapi juga sebagai langkah inovatif menuju sistem PLTS 

yang adaptif terhadap kondisi lingkungan secara real-time. 

 

2.2 Dasar Teori 

Dalam merancang sistem pembersih panel surya otomatis berbasis 

ESP32 dengan deteksi partikulat debu PM2.5 dan penjadwalan rutin, 

diperlukan pemahaman mendalam mengenai integrasi teknologi 

mikrokontroler, sensor lingkungan, serta penerapan stPenggunar baku 

mutu debu sesuai PP No. 22 Tahun 2021. Penggabungan konsep-konsep 

tersebut menjadi lPenggunasan utama dalam pengembangan sistem yang 

tidak hanya mampu bekerja secara otomatis dan efisien, tetapi juga 

responsif terhadap kondisi lingkungan sekitar. Oleh karena itu, penjelasan 

mengenai dasar teori yang mendasari setiap komponen sistem sangat 

penting untuk memastikan bahwa rancangan yang dihasilkan dapat 

memenuhi stPenggunar kinerja dan regulasi yang berlaku. 

 

2.2.1 Panel Surya (Photovoltaic) 

Sel surya, unit dasar dari teknologi fotovoltaik, pada dasarnya adalah 

dioda foto berukuran besar yang mampu menghasilkan energi listrik. 

Material fotovoltaik tersusun dari dua jenis bahan yang berbeda, yang 

terhubung melalui sambungan (junction). Ketika cahaya mengenai 

permukaan sambungan ini, energi cahaya dikonversi menjadi arus listrik 

searah (DC). Untuk menghasilkan daya yang lebih besar, beberapa sel surya 

dirangkai bersama dalam sebuah wadah yang disebut modul surya atau 

panel surya. Ilustrasi penampang melintang sel surya sebagai pembangkit 

listrik dapat dilihat pada Gambar 2.1. [4] 
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Gambar 2. 1 Sistem Kerja Panel Surya [4] 

Terdapat dua kategori utama modul surya yang umum digunakan, 

yaitu silikon kristalin dan lapisan tipis (thin film). Modul silikon kristalin 

dibuat dari bahan silikon, sedangkan modul lapisan tipis umumnya 

menggunakan material kimia. Modul silikon kristalin sendiri terbagi 

menjadi dua tipe: monokristalin dan polikristalin. Setiap tipe menawarkan 

tingkat efisiensi yang berbeda; monokristalin berkisar antara 14-16%, 

sementara polikristalin memiliki efisiensi 13-15%. Modul surya lapisan 

tipis hadir dalam berbagai varian yang penamaannya didasarkan pada 

material penyusunnya, seperti A-Si:H, CdTe, dan CIGs (ditampilkan pada 

Gambar 2.4). Efisiensi rata-rata untuk modul lapisan tipis berada pada 

rentang 6,5-8%. Akibat perbedaan efisiensi ini, modul dengan kapasitas 

yang sama akan memiliki ukuran fisik yang berbeda, yang pada akhirnya 

memengaruhi kebutuhan lahan untuk pemasangan. 

Kapasitas modul surya, yang diukur dalam satuan Watt peak (Wp), 

tersedia dalam berbagai ukuran. Dalam aplikasi pembangkit listrik, ukuran 

modul yang umum digunakan berkisar antara 80 hingga 300 Wp per modul. 

Untuk meningkatkan tegangan, modul-modul tersebut dirangkai secara 

seri, sedangkan untuk meningkatkan arus, modul-modul tersebut disusun 

secara paralel. 
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Gambar 2. 2 Monokristalin,polikristalin,A-Si:H[4] 

Kapasitas panel surya yang dibutuhkan (dinyatakan dalam kWp atau 

kilowatt peak) ditentukan oleh jumlah energi (kWh atau kilowatt-hour) 

yang dikonsumsi beban dalam periode waktu tertentu dan intensitas radiasi 

matahari di lokasi pemasangan polikristalin 

Efisiensi panel surya dapat dipengaruhi oleh berbagai faktor, 

termasuk suhu, kualitas koneksi kabel, efisiensi inverter, kondisi baterai 

(jika ada), dan lain-lain. 

Oleh karena itu, perhitungan kapasitas ideal seringkali disesuaikan 

dengan faktor derating (penurunan kinerja) yang umumnya bernilai sekitar 

0,67 atau 67%. Faktor derating ini mengkompensasi potensi kehilangan 

daya akibat faktor-faktor yang disebutkan di atas 

Jumlah energi yang ingin diproduksi (Eo, kWh) bergantung pada 

radiasi matahari di lokasi (H, kWh/m²/hari), iradiasi stPenggunar (Io = 1 

kW/m²), efisiensi modul (Η, %), faktor koreksi suhu (Cf, 1,1 – 1,5), jam 

puncak matahari (PSH) minimum da lam periode waktu tertentu, dan 

efisiensi total sistem (𝜂𝑠𝑚, 0,67 – 0,75). Modul surya dirangkai secara seri 

(membentuk string) untuk memperoleh tegangan yang sesuai, dan 

beberapa string dirangkai paralel untuk meningkatkan daya atau arus. 

Tegangan string kemudian dicocokkan dengan kebutuhan tegangan input 

inverter.  

Pemilihan jenis panel surya yang tepat akan sangat berpengaruh 

terhadap efisiensi, biaya, dan aplikasi penggunaannya, baik untuk 

kebutuhan rumah tangga, komersial, maupun industri. Berikut penjelasan 

mengenai berbagai jenis panel surya yang tersedia di pasaran saat ini:  
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1. Monokristalin 

Tipe panel surya monokristalin merupakan jenis yang paling populer 

dan banyak digunakan saat ini, dikenal karena tingkat efisiensinya 

yang berkisar antara 12 hingga 14%, Panel Surya Monokristalin 

ditunjukkan pada gambar 2.3 [5] 

                

Gambar 2. 3 Panel surya Monokristalin[5] 

2. Polikristalin 

Panel surya polikristalin, juga dikenal sebagai multi kristalin, dibuat 

dari Kristal silikon dan memiliki tingkat efisiensi antara 10 hingga 

12%, Panel Surya Polikristalin ditunjukkan pada gambar 2.4. 

 

Gambar 2. 4 Panel Surya Polikristalin 

3. Thin Film 

Sel Surya thin-film (TFPV), sel surya generasi kedua yang ringan dan 

fleksibel, menggunakan lapisan tipis silikon mikrokristalin dan amorf. 

Efisiensi modulnya mencapai 8,5%, sehingga membutuhkan area 

permukaan lebih besar per watt dibandingkan sel kristalin. Konversi 

energi tetap melalui efek fotovoltaik. [5] 
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Gambar 2. 5 Sel Surya thin-film (TFPV) 

Gambar 2.5 merupakan Panel Surya thin-film, Ada beberapa jenis sel 

surya Thin Film yang masing- masing terbuat dari bahan yang berbeda dan 

mempengaruhi keseluruhan biaya dan efisiensi panel. Namun, semua sel 

surya Thin Film mengandung bahan fotovoltaik, lembaran konduktif, dan 

lapisan pelindung.  

 

2.2.2 Alat Pembersih Panel Surya  

Alat pembersih panel surya menjadi solusi penting untuk 

mempertahankan kebersihan panel melalui pembersihan rutin. 

Pengembangan alat ini, baik melalui penelitian maupun produk komersial 

yang inovatif, krusial untuk mendukung kemajuan Pembangkit Listrik 

Tenaga Surya (PLTS) di masa depan. Hal ini didukung oleh proyeksi 

peningkatan signifikan jumlah pembangunan PLTS akibat target pemerintah 

dalam mendorong energi bersih, meningkatnya kesadaran masyarakat akan 

manfaat PLTS, dan penurunan biaya instalasi PLTS. 

Terdapat Teknik-teknik dalam pembersihan panel surya menjadi dua 

kategori utama: manual dan otomatis. Metode manual yang sering 

digunakan melibatkan penyemprotan air bertekanan tinggi melalui selang. 

Selain itu, beberapa metode manual lainnya menggunakan alat bantu seperti 

penyemprot cairan, squeegee, dan wiper lembut untuk membantu proses 

pembersihan. teknik pembersihan panel surya otomatis telah dikembangkan 

dalam beberapa jenis. Salah satunya adalah robot bergerak yang dilengkapi 
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dengan wiper yang bergerak secara vertikal dan horizontal, serta sistem 

penyemprotan air menggunakan pompa dan selang. Jenis robot otomatis 

lainnya menggunakan sikat berputar yang bergerak mengikuti arah alat, juga 

dengan dukungan penyemprotan air. Selain itu, ada juga robot pembersih 

otomatis yang memanfaatkan kain flanel bergerak untuk menggosok 

permukaan panel, yang juga dilengkapi dengan sistem penyemprotan air. 

Selain robot bergerak, terdapat juga sistem pembersih panel surya 

otomatis yang dirancang untuk terpasang secara permanen pada rangka 

panel surya. Teknologi canggih ini mencakup beberapa varian, di antaranya 

adalah robot yang dilengkapi dengan wiper yang bergerak vertikal dan 

horizontal, serta pompa air untuk menyemprotkan air melalui selang ke 

panel. Varian lain menggunakan wiper yang bergerak vertikal pada 

kerangka penyangga yang dapat bergerak horizontal, juga dengan sistem 

penyemprotan air. Ada pula robot permanen yang menggunakan sikat yang 

bergerak baik secara vertikal maupun horizontal, dilengkapi dengan pompa 

air. Bahkan, terdapat sistem yang hanya mengPenggunalkan pompa air 

untuk menyemprotkan air ke panel, serta robot yang menggunakan 

kemoceng yang bergerak horizontal untuk membersihkan permukaan.[3] 

  

1. Telescopic Pole dengan Sikat dan Water Pump 

Alat pembersih panel surya jenis ini merupakan perangkat manual 

yang terdiri dari sebuah tongkat teleskopik panjang yang dilengkapi dengan 

sikat pembersih dan pompa air. Pengguna dapat mengoperasikan alat ini 

secara langsung untuk membersihkan permukaan panel surya yang sulit 

dijangkau, terutama pada instalasi yang berada di ketinggian atau area luas. 

Pompa air berfungsi untuk membantu menghilangkan kotoran yang 

menempel dengan cara menyemprotkan air secara merata ke permukaan, 

Alat pembersih panel surya sapu telescopic extentool ditunjukkan pada 

Gambar 2.6.[3] 
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Gambar 2. 6 Sapu Manual dengan Air dan Sikat[3] 

 

2. Robot Tetap (Fixed) dengan Metode Dry Clean dan Water Clean 

Robot pembersih panel surya yang dipasang secara permanen ini 

menawarkan solusi otomatis yang efisien untuk instalasi panel berskala 

besar. Dengan mekanisme wiper atau sikat yang dapat melakukan 

pembersihan kering maupun basah, robot ini mampu membersihkan panel 

secara berkala tanpa memerlukan intervensi manusia. Sistem penyemprotan 

air terintegrasi mendukung pembersihan yang lebih menyeluruh, sehingga 

panel selalu dalam kondisi optimal untuk menyerap energi matahari. 

Penggunaan robot tetap ini sangat cocok untuk fasilitas pembangkit listrik 

tenaga surya komersial yang membutuhkan pemeliharaan kontinu dan 

minim tenaga kerja,Alat pembersih panel surya Robot Tetap (Fixed) 

ditunjukkan pada Gambar 2.7. [3] 

               

Gambar 2. 7 Robot Tetap (Fixed)[3] 
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3.    Robot Portabel dengan Sikat Rol Panjang 

Robot portabel ini menawarkan fleksibilitas tinggi dalam 

pemeliharaan panel surya yang tersebar di berbagai lokasi. Dilengkapi 

dengan sikat rol panjang, robot ini mampu membersihkan permukaan 

panel secara efektif dan efisien. Keunggulan utama dari robot ini adalah 

kemampuannya untuk dipindahkan dan digunakan pada berbagai 

instalasi tanpa pemasangan permanen. Hal ini sangat menguntungkan 

untuk pemilik instalasi panel surya berskala menengah hingga besar yang 

membutuhkan solusi pembersihan yang cepat dan mudah dioperasikan. 

Robot Portabel dengan Sikat Rol Panjang ditunjukkan pada gambar 2.8.  

 

 

Gambar 2. 8 Robot Ekskavator dengan Sikat Rol Panjang 

 

2.2.2.1 Peraturan Pemerintah RI Nomor 22 Tahun 2021 

Dalam upaya menjaga efisiensi kerja panel surya, penting untuk 

memperhatikan faktor lingkungan yang memengaruhi kinerjanya, salah 

satunya adalah tingkat polusi debu. Salah satu parameter pencemar debu 

yang sangat relevan terhadap penurunan efisiensi panel surya adalah partikel 

partikulat berukuran kecil, khususnya PM2.5 (particulate matter berukuran 

≤2,5 mikron).[6] 
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Gambar 2. 9 PP Republik Indonesia  

Nomor 22 Tahun 2021[6] 

  Berdasarkan Peraturan Pemerintah Republik Indonesia Nomor 22 

Tahun 2021 tentang Penyelenggaraan Perlindungan dan Pengelolaan 

Lingkungan Hidup, telah ditetapkan baku mutu debu ambien nasional, 

termasuk ambang batas harian konsentrasi PM2.5, yaitu 55 µg/m³.[6] 

Debu yang terkandung dalam PM2.5 dapat mengendap pada 

permukaan panel surya, sehingga menyebabkan penurunan efisiensi 

konversi energi listrik. Penumpukan debu ini menghambat penetrasi cahaya 

matahari ke modul fotovoltaik, yang secara langsung mempengaruhi kinerja 

sistem pembangkit listrik tenaga surya (PLTS). Oleh karena itu, 

pengendalian pencemaran, khususnya debu halus, menjadi sangat penting 

untuk mendukung optimalisasi pemanfaatan energi terbarukan. 

Dalam konteks ini, Peraturan Pemerintah No. 22 Tahun 2021 berperan 

sebagai dasar regulasi yang mendorong pengendalian sumber pencemaran 

debu di lingkungan sekitar instalasi panel surya. Selain itu, peraturan ini juga 

menjadi lPenggunasan bagi penerapan langkah-langkah mitigasi, seperti 

pembersihan panel surya secara berkala untuk mengurangi dampak 

penumpukan debu dan menjaga efisiensi sistem PLTS. 

Selaras dengan hal tersebut, Peraturan Menteri Energi dan Sumber 

Daya Mineral Nomor 2 Tahun 2024 tentang Pembangkit Listrik Tenaga 

Surya Atap menegaskan pentingnya pemeliharaan dan pengoperasian panel 

surya yang optimal, termasuk kegiatan pembersihan panel sebagai bagian 
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dari prosedur operasional stPenggunar. Dengan demikian, pengaturan 

kualitas dalam PP No. 22 Tahun 2021 mendukung keberlanjutan dan 

efektivitas pemanfaatan energi surya melalui pengurangan pencemaran 

debu dan penerapan pembersihan panel surya yang tepat. 

 

2.2.4 Mikrokontroler 

 Mikrokontroler adalah sebuah sistem komputer mini yang dikemas 

dalam satu chip tunggal (Integrated Circuit/IC) yang berisi inti prosesor 

(CPU), memori (RAM, ROM/Flash), dan perangkat input/output (I/O) yang 

memungkinkan mikrokontroler untuk melakukan pengolahan data dan 

pengendalian perangkat secara otomatis berdasarkan program yang telah 

dimasukkan. Mikrokontroler sering disebut sebagai "komputer dalam chip" 

karena mampu menjalankan fungsi komputer namun dalam ukuran yang 

sangat kecil dan efisien dari segi biaya dan konsumsi daya[7] [8] 

Setelah memahami pengertian dan fungsi dasar mikrokontroler 

sebagai otak pengendali perangkat elektronik, Perkembangan teknologi 

mikrokontroler yang semakin canggih. Salah satu contohnya adalah ESP32, 

yang tidak hanya memiliki kemampuan pemrosesan yang baik, tetapi juga 

dilengkapi fitur konektivitas Wi-Fi dan Bluetooth. Hal ini menjadikan 

ESP32 sangat populer untuk berbagai aplikasi Internet of Things (IoT) dan 

pengembangan sistem pintar masa kini. 

ESP32 adalah mikrokontroler yang dikembangkan oleh Espressif 

Systems sebagai penerus dari mikrokontroler ESP8266. Mikrokontroler ini 

sudah dilengkapi dengan modul WiFi yang terintegrasi dalam satu chip, 

sehingga sangat mendukung pembuatan aplikasi Internet of Things (IoT).  

Modul ESP32-WROOM-32 dilengkapi dengan mikroprosesor 

Xtensa dual-core 32-bit LX6 yang mampu beroperasi hingga frekuensi 240 

MHz. Modul ini memiliki memori SRAM sebesar 520 kB dan flash memori 

berkapasitas 4 MB. Untuk konektivitas nirkabel, modul ini mendukung 

stPenggunar WiFi 802.11 b/g/n serta Bluetooth versi 4.2 dengan 

kemampuan Bluetooth Low Energy (BLE). Modul ini menyediakan 48 pin 
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GPIO yang dapat digunakan sebagai input atau output, termasuk 15 kanal 

ADC (Analog to Digital Converter), 25 kanal PWM (Pulse Width 

Modulation), dan 2 kanal DAC (Digital to Analog Converter) untuk 

berbagai aplikasi pengendalian perangkat elektronik.[7] 

 

Gambar 2. 10 ESP32 DEV KIT 1[7] 

Pada Gambar 2.9 merupakan ESP32 DEV KIT 1, ESP32 DevKit V1 

merupakan papan pengembangan yang mengintegrasikan modul ESP32-

WROOM-32 dengan komponen pendukung seperti regulator tegangan, 

konektor USB, dan pin header yang memudahkan akses ke berbagai fungsi 

mikrokontroler, Pada Tabel merupakan spesifikasi utama ESP32 DevKit V1 

yang merangkum fitur-fitur penting dari board ini. 

 

Tabel 2. 1 SPESIFIKASI ESP32 DEV KIT 1[7] 

             SPESIFIKASI ESP32 DEV KIT V1 

Mikrokontroler Tensilica 32-bit Single-

/Dual-core 

CPU Xtensa LX6 

Memory 520 KiB SRAM 

Digital input-output 

(DIO) pins 

25 

Analog Input (ADC) 

pins 

6 
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Analog Output (DAC) 

Pins 

2 

UARTs 3 

SPIs 2 

I2Cs: 3 3 

Flash Memory 4 MB 

Clock Speed 240 Mhz 

Wi-Fi IEEE 802.11 b/g/n/e/ 

Dimensions 51.5x29x5mm 

 

Setelah memahami spesifikasi ESP32 DevKit V1 yang menjelaskan 

fitur utama dan kemampuan hardware, perlu dilakukan pembahasan 

mengenai pinout board tersebut. Pinout memberikan informasi detail 

tentang fungsi dan posisi setiap pin pada board, sehingga memudahkan 

dalam pengkabelan dan pemrograman perangkat eksternal. Dengan 

demikian, pemahaman pinout menjadi langkah penting untuk 

mengoptimalkan penggunaan ESP32 sesuai dengan spesifikasi yang telah 

dijelaskan. 

 

Gambar 2. 11 Pinout ESP32 DEV KIT 1[7] 

Gambar 2.11 merupakan pinout ESP32 DevKit V1 yang 

memperlihatkan tata letak fisik dan posisi pin pada board, langkah 
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berikutnya adalah menguraikan tabel pinout secara rinci. Tabel ini memuat 

informasi fungsi setiap pin, seperti GPIO, power, ground, dan antarmuka 

komunikasi, sehingga memudahkan dalam identifikasi dan pemanfaatan pin 

sesuai kebutuhan aplikasi. Dengan adanya tabel pinout, pemahaman 

terhadap konfigurasi pin menjadi lebih sistematis dan terstruktur, table pin 

out dapat dilihat pada Tabel 2.2. 

Tabel 2. 2 Pinout ESP32 DEV KIT 1[8] 

Jenis Pin Fungsi 

Utama 

Kegunaan Keterangan 

GPIO General 

Purpose Input 

Output) 

Input/Output 

Digital 

Membaca sinyal 

digital dari sensor, 

mengendalikan 

aktuator seperti LED, 

relay, dll. 

Dapat 

dikonfigurasi 

sebagai input 

atau output 

ADC Analog 

to Digital 

Converter) 

Konversi sinyal 

analog ke digital 

Membaca nilai sensor 

analog seperti sensor 

suhu, cahaya, 

potensiometer 

ESP32 

memiliki 12-

bit ADC, 

beberapa pin 

mendukung 

ADC 

DAC Digital 

to Analog 

Converter) 

Konversi sinyal  

digital ke analog 

Menghasilkan 

sinyal analog 

seperti output audio 

atau kontrol motor 

Tersedia 

pada 

beberapa pin 

tertentu 

PWM 

Pulse 

Width 

Modulation

) 

Menghasilka

n sinyal 

PWM 

Mengontrol kecepatan 

motor, intensitas LED, 

dan perangkat yang 

memerlukan sinyal 

PWM 

Pin GPIO 

dapat 

digunakan 

untuk PWM 

UART Komunikasi Menghubungkan Biasanya 



24 
 

 

 

Universal 

Asynchronous 

Receiver 

Transmitter) 

serial ESP32 dengan 

perangkat serial 

seperti modul GPS, 

Bluetooth, atau 

komputer 

menggunakan 

pin khusus 

RX dan TX 

I2CInter-

Integrated 

Circuit) 

Komunikasi 

data dua arah 

dengan 

beberapa 

perangkat 

Menghubungkan 

sensor, display, dan 

modul lain secara 

bersamaan 

menggunakan dua 

kabel SDA, SCL 

Pin khusus 

SDA dan SCL 

SPI Serial 

Peripheral 

Interface) 

Komunikasi  

serial cepat 

Menghubungkan 

perangkat dengan 

kecepatan tinggi 

seperti memori 

eksternal, display TFT 

Pin khusus 

MOSI, 

MISO, 

SCK 

Strapping 

Pins 

Menentukan 

mode 

booting 

ESP32 

Mengatur mode 

booting seperti flash 

mode atau download 

mode 

Harus 

diperhatikan 

saat desain 

hardware 

 

2.2.4.1 Arduino IDE  

   Arduino IDE (Integrated Development Environment) merupakan 

perangkat lunak open-source yang digunakan untuk menulis, mengedit, 

mengunggah, dan memantau kode program (sketch) yang akan dijalankan 

oleh mikrokontroler berbasis Arduino. Lingkungan pengembangan ini 

dirancang untuk memudahkan pengguna dari berbagai latar belakang, baik 

pemula maupun profesional, dalam membangun berbagai proyek 

elektronika dan IoT (Internet of Things).[9] 
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Gambar 2. 12 Tampilan Arduino IDE[9] 

Gambar 2.12 merupakan tampilan dari software Arduino IDE, 

Tampilan Arduino IDE terdiri dari menu bar untuk pengelolaan file dan 

pengaturan, toolbar dengan tombol kompilasi dan upload, serta editor kode 

untuk penulisan program. Konsol log menampilkan hasil kompilasi dan 

pesan error, sementara serial monitor berfungsi sebagai antarmuka 

komunikasi data antara komputer dan board. Status bar memberikan 

informasi tentang board dan port yang digunakan. Keseluruhan fitur ini 

memudahkan proses pengembangan dan debugging program secara efektif 

Arduino IDE mendukung berbagai jenis papan (board) Arduino, 

seperti Arduino Uno, Mega, Nano, dan lainnya. IDE ini menggunakan 

bahasa pemrograman yang berdasarkan bahasa C/C++, namun telah 

disederhanakan agar lebih mudah dipahami.  

Setelah memahami antarmuka dan fitur utama pada Arduino IDE, 

tahap berikutnya adalah mempelajari prosedur penggunaan perangkat lunak 

ini secara praktis. Proses penggunaan dimulai dengan menghubungkan 

board mikrokontroler ke komputer menggunakan kabel USB, seperti pada 

gambar 2.12.  
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Gambar 2. 13 Mikrokontroler ke port USB 

Untuk memastikan mikrokontroler sudah terdeteksi komputer, buka 

menu Tools > Port di Arduino IDE. Jika terhubung dengan benar, akan 

muncul port seperti COM42 pada gambar 2.13. (nomor port bisa berbeda tiap 

komputer). Biasanya, driver sudah terinstal otomatis saat memasang Arduino 

IDE. Jika port tidak muncul, cek kabel USB atau instalasi driver. 

 

Gambar 2. 14 Port mikrokontroler 

Langkah selanjutnya adalah memilih jenis board atau mikrokontroler 

yang akan digunakan pada Arduino IDE. Hal ini penting karena Arduino IDE 
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mendukung berbagai jenis mikrokontroler, sehingga pemilihan board yang 

sesuai dengan perangkat yang akan diprogram diperlukan agar proses 

kompilasi dan pengunggahan berjalan dengan benar. Untuk mikrokontroler 

ESP32, pengguna dapat memilihnya melalui menu Tools > Board > ESP32 

Arduino Boards. Dengan melakukan pengaturan ini, Arduino IDE akan 

menyesuaikan konfigurasi dan pustaka yang diperlukan untuk pemrograman 

ESP32 secara optimal, Seperti gambar 2.14.  

          

Gambar 2. 15 Pemilihan Mikrokontroler 

Setelah melakukan pengaturan board dan port, langkah berikutnya 

adalah menulis kode program pada editor di Arduino IDE. Sebelum mulai 

menulis kode di Arduino IDE, pastikan library yang dibutuhkan sudah 

terpasang. Library ini berisi fungsi-fungsi tambahan yang memudahkan 

pemrograman perangkat seperti ESP32. Kamu bisa menambahkan library 

melalui menu Sketch > Include Library > Manage Libraries, lalu cari dan 

pasang library yang sesuai dengan kebutuhan proyek. 

Pada tahap ini, pengguna membuat instruksi sesuai dengan fungsi 

yang diinginkan, mulai dari pengaturan awal di fungsi Setup() hingga logika 

utama di fungsi loop(). Penulisan kode harus dilakukan dengan cermat agar 

tidak terjadi kesalahan saat kompilasi dan pengunggahan. Dengan menulis 

kode secara terstruktur, mikrokontroler ESP32 dapat menjalankan berbagai 
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aplikasi sesuai kebutuhan proyek, penulisan kode di Arduino IDE seperti 

padan Gambar 2.15.  

 

 

Gambar 2. 16 Penulisan Program di Arduino IDE 

Setelah menulis program selesai, langkah berikutnya adalah 

mengunggah kode ke board ESP32 dengan cara mengklik 

tombol Upload pada toolbar Arduino IDE, yang ditPenggunai dengan ikon 

panah ke kanan (posisi kedua dari kiri) seperti pada Gambar 2.16.  

 

Gambar 2. 17 Upload program di Arduino IDE 

Setelah tombol ditekan, tunggu hingga proses upload selesai. Pada 

beberapa board ESP32, saat muncul pesan "Connecting..." di bagian bawah, 

pengguna perlu menekan dan menahan tombol BOOT pada board hingga 

proses upload berjalan dan muncul pesan "Done uploading". Proses ini 

memastikan program berhasil ditransfer dan siap dijalankan pada 

mikrokontroler, seperti pada gambar 2.17.  

 

Gambar 2. 18 Program berhasil di upload Arduino IDE 
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2.2.5 RTC (Real Time Clock) 

Real-Time Clock (RTC) adalah komponen penting dalam sistem 

embedded yang memerlukan pencatatan waktu secara akurat dan 

berkelanjutan. RTC DS3231 adalah IC (Integrated Circuit) RTC yang 

terintegrasi dengan osilator kristal yang dikompensasi suhu (TCXO) untuk 

memberikan akurasi tinggi. Komponen ini sangat cocok untuk aplikasi yang 

memerlukan ketepatan waktu dalam jangka panjang, bahkan saat sumber 

daya utama terputus, Gambar 2.19 menunjukkan modul RTC. [10] 

 

                     

Dalam sistem otomatis seperti alat pembersih panel surya berbasis 

mikrokontroler, RTC berperan penting dalam: 

A. Membantu sistem melakukan pengecekan kondisi debu secara rutin 

pada waktu-waktu tertentu (pukul 04.00 dan 19.00), sehingga alat 

dapat menentukan apakah perlu melakukan pembersihan atau tetap 

standby berdasarkan nilai PM2.5 saat itu. 

B. Memungkinkan sistem berjalan secara mandiri tanpa campur tangan 

manusia secara langsung. 

Gambar 2. 19 Real Time Clock (RTC)[10] 
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Gambar 2. 20 Blok Diagram RTC (Real time Clock) 

 

Pada Gambar 2.20 Blok diagram yang menggambarkan rangkaian 

Real Time Clock (RTC) yang terdiri dari beberapa komponen utama, yaitu 

IC RTC sebagai inti pengatur waktu, kristal osilator TCXO (Temperature 

Compensated Crystal Oscillator) berfrekuensi 32 kHz yang berfungsi 

menjaga akurasi waktu, serta dilengkapi dengan berbagai sensor dan sumber 

daya berupa baterai. IC RTC berperan sebagai pencatat waktu secara real-

time, sedangkan kristal TCXO memberikan kestabilan frekuensi sehingga 

penghitungan waktu tetap presisi meskipun terjadi perubahan suhu 

lingkungan. Selain itu, baterai digunakan untuk memastikan RTC tetap aktif 

dan dapat menyimpan data waktu meskipun catu daya utama terputus. 

Sensor-sensor yang terhubung berfungsi sebagai input tambahan yang dapat 

digunakan sesuai kebutuhan sistem, misalnya untuk monitoring atau 

pengendalian otomatis 
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Spesifikasi sensor RTC dapat dilihat pada Tabel 2.3, yang merupakan 

penjelasan lebih rinci dari blok diagram sebelumnya. Tabel tersebut memuat 

detail teknis sensor RTC, seperti jenis sensor, protokol komunikasi, dan fitur 

utama yang mendukung fungsi pengukuran waktu secara akurat dalam 

sistem. Dengan merujuk pada tabel ini, pembaca dapat memahami 

karakteristik sensor secara lengkap sebagai dasar untuk implementasi dalam 

rangkaian yang telah dijelaskan pada blok diagram. 

 

Tabel 2. 3 Spesifikasi RTC DS3231[10] 

No. Spesifikasi Keterangan 

1 Nama Chip DS3231 

2 Protokol 

Komunikasi 

I2C (Inter-Integrated Circuit) 

3 Tegangan Operasi 3.3V – 5.5V 

4 Akurasi Waktu ±2 ppm (sekitar ±1 menit per tahun) 

5 Format Waktu 24 jam atau 12 jam dengan indikator 

AM/PM 

6 Fitur Alarm Dua alarm independen dengan output 

interrupt 

7 Kompensasi Suhu Ya, internal (temperature-compensated 

crystal oscillator) 

8 Output Tambahan Square-Wave Output (pin SQW) 

9 Baterai Cadangan CR2032 Lithium Coin Cell (untuk menjaga 

waktu saat daya utama mati) 

10 Suhu Operasional -40°C hingga +85°C 

11 Dimensi Modul 

(umum) 

Sekitar 38 mm × 22 mm (bisa berbeda 

tergantung produsen modul) 

12 Memori 

Tambahan 

(opsional) 

EEPROM AT24C32 (32 KB) pada beberapa 

versi modul RTC 
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Setelah menjelaskan spesifikasi sensor RTC pada tabel sebelumnya, 

selanjutnya perlu dipahami pinout modul DS3231.  

              

Gambar 2. 21 Pinout RTC DS3231[10]  

Pada Gambar 2.21 Pinout RTC DS3231 menunjukkan fungsi dan 

posisi tiap pin pada modul, seperti VCC dan GND untuk catu daya, serta 

SDA dan SCL untuk komunikasi I2C dengan mikrokontroler ESP32. Selain 

itu, terdapat pin SQW sebagai output gelombang persegi dan pin 32K untuk 

output oscillator 32 kHz. Memahami pinout ini penting agar pengkabelan 

dan integrasi modul RTC dengan ESP32 dapat dilakukan dengan tepat 

sesuai spesifikasi yang telah dijelaskan, penjelasan lebih lanjut mengenai 

Pinout RTC DS3231 dilampirkan pada table 2.4.                   

 

Tabel 2. 4 Pinout RTC DS323[10] 

Nama 

Pin 

Fungsi  

VCC Sumber tegangan utama untuk mengoperasikan modul. 

Biasanya 3.3V atau 5V. 

GND Ground, terhubung ke ground sistem. 

SDA Serial Data, jalur data untuk komunikasi I2C dengan 

mikrokontroler. 

SCL Serial Clock, jalur clock untuk komunikasi I2C. 
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SQW 

/INT 

Output gelombang kotak (square wave) yang dapat 

diprogram frekuensinya, atau sebagai output interrupt 

alarm. 

32K Output oscillator 32.768 kHz, dapat digunakan sebagai 

sumber clock eksternal (optional). 

VBAT Input tegangan baterai cadangan untuk menjaga fungsi 

RTC saat VCC mati. 

RST Pin reset, berfungsi sebagai input pushbutton reset 

eksternal dan indikator power-fail. 

 

Setelah memahami fungsi dari masing-masing pin pada modul RTC 

DS3231, dapat diketahui bahwa setiap pin memiliki peran penting dalam 

mendukung operasi modul secara keseluruhan. Konfigurasi pin yang tepat 

memastikan modul dapat terhubung dengan baik ke mikrokontroler dan 

sumber daya, sehingga proses komunikasi dan pengambilan data waktu 

dapat berjalan secara optimal. Dengan lPenggunasan tersebut, berikut akan 

dijelaskan bagaimana cara kerja RTC DS3231 dalam menjaga dan 

mengelola data waktu secara akurat pada sistem yang terintegrasi. 

      

Gambar 2. 22 Diagram Koneksi  

Modul RTC DS3231 dengan Mikrokontroler[10] 

  Pada Gambar 2.10 Modul DS3231 dihubungkan ke sumber tegangan 

+5V sesuai dengan diagram rangkaian. Modul ini dirancang untuk 

beroperasi pada tegangan +5V yang sudah terregulasi, dan penggunaan 

tegangan yang lebih tinggi dari itu dapat merusak modul. Antarmuka 

komunikasi I2C antara modul dan mikrokontroler dilakukan dengan 
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menghubungkan pin SDA modul ke pin SDA mikrokontroler, serta pin SCL 

modul ke pin SCL mikrokontroler. 

Proses komunikasi antara mikrokontroler dan modul RTC DS3231 

cukup kompleks, karena data dikirim dan diterima secara byte per byte. Oleh 

karena itu, pemanfaatan library khusus yang telah dibuat untuk modul 

DS3231 sangat dianjurkan. Library ini memudahkan proses komunikasi, 

sehingga pengguna hanya perlu mengunduh dan mengintegrasikan library 

tersebut ke dalam program. Setelah header file library dimasukkan, 

mikrokontroler dapat secara otomatis melakukan komunikasi dengan modul 

dan menyediakan data waktu serta tanggal secara akurat. Selain itu, 

pengaturan alarm pada modul juga dapat dilakukan dengan mudah melalui 

library tersebut[10] 

Ketika terjadi pemadaman listrik, modul RTC secara otomatis 

mengambil sumber daya dari baterai cadangan yang terhubung, sehingga 

waktu tetap terjaga dengan akurat. Saat sistem kembali menyala, 

mikrokontroler dapat memperoleh data waktu nyata dari modul tanpa 

mengalami kesalahan atau kehilangan data waktu. 

 

2.2.6 Sensor Debu GP2Y1010AU0F 

SHARP GP2Y1010AU0F merupakan modul sensor yang mampu 

mengukur konsentrasi partikel debu, bahkan dapat membedakan antara debu 

dan asap. Sensor ini bekerja dengan mendeteksi partikel yang melintasi LED 

dan photodioda di dalam modul. Perubahan intensitas cahaya yang diterima 

oleh photodioda digunakan untuk menunjukkan tingkat kepadatan debu, 

Gambat menunjukan fisik Sensor Debu GP2Y1010AU0F.[11] 
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Gambar 2. 23 Sensor Debu GP2Y1010AU0F 

Sensor GP2Y1010AU0F memiliki beberapa fitur utama[11]: 

1. Dimensi kompak dan tipis (46 x 30 x 17.6 mm) 

2. Menggunakan sistem output pulsa, memungkinkan deteksi partikel 

debu berukuran kecil 

3. Dapat membedakan antara partikel debu rumah dan asap rokok 

Sensor ini bekerja dengan prinsip deteksi pantulan cahaya. Di dalam sensor 

terdapat LED (Light Emitting Diode) sebagai pemancar cahaya dan 

fotodioda sebagai penerima cahaya. Keduanya dilengkapi dengan lensa 

dan celah (slit) yang berfungsi untuk memfokuskan cahaya dan 

meminimalkan gangguan dari cahaya luar. Area deteksi utama adalah titik 

di mana sumbu optik dari LED dan fotodioda bertemu. 

Ketika tidak ada partikel debu, cahaya dari LED akan sedikit dipantulkan 

oleh bagian dalam casing sensor dan sebagian kecil diterima oleh 

fotodioda, menghasilkan tegangan output dasar yang dikenal sebagai Voc 

(Voltage Output Clean Air). Sebaliknya, ketika terdapat partikel debu atau 

asap, cahaya dari LED akan dipantulkan oleh partikel tersebut dan diterima 

oleh fotodioda dalam jumlah yang lebih besar. Arus yang dihasilkan oleh 

fotodioda akan diperkuat oleh rangkaian amplifier dan dikonversi menjadi 

tegangan analog berbentuk pulsa. 
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Sensor debu bekerja dengan mengukur perubahan tegangan yang 

dipengaruhi oleh kepadatan partikel debu di debu. Output sensor ini 

merupakan gabungan dari tegangan dasar (Voc) dan tegangan tambahan 

(ΔV) yang sebanding dengan jumlah debu yang terdeteksi. Secara 

matematis, tegangan tambahan dihitung dengan rumus:                                     

ΔV = Vo – Voc 

Setelah memahami prinsip kerja sensor debu yang mengubah pantulan 

cahaya dari partikel debu menjadi sinyal tegangan, selanjutnya penting 

untuk melihat spesifikasi teknis sensor tersebut. Spesifikasi ini menjelaskan 

sensitivitas sensor, rentang pengukuran, tegangan operasi, dan karakteristik 

lainnya yang menentukan seberapa akurat dan responsif sensor dalam 

mendeteksi kadar debu di debu. Dengan mengetahui spesifikasi secara 

lengkap, pengguna dapat memastikan sensor yang digunakan sesuai dengan 

kebutuhan sistem dan dapat diintegrasikan dengan mikrokontroler secara 

optimal. 

Dimana Vo adalah tegangan yang terukur saat ada debu, dan Voc 

adalah tegangan dasar saat kondisi debu bersih tanpa debu. 

Seiring waktu, nilai tegangan ini bisa berubah karena penumpukan 

debu di dalam sensor, sehingga penting untuk menyimpan nilai tegangan 

dasar (Voc) di memori mikrokontroler dan memperbaruinya secara berkala. 

                         Gambar 2. 24 Prinsip Kerja Sensor GP2Y1010AU0F[11] 
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Dengan cara ini, sistem dapat menyesuaikan pembacaan sensor agar tetap 

akurat meskipun kondisi sensor berubah. 

Setelah memahami prinsip kerja sensor debu yang mengubah pantulan 

cahaya dari partikel debu menjadi sinyal tegangan, selanjutnya penting 

untuk melihat spesifikasi teknis sensor tersebut. Spesifikasi ini menjelaskan 

sensitivitas sensor, rentang pengukuran, tegangan operasi, dan karakteristik 

lainnya yang menentukan seberapa akurat dan responsif sensor dalam 

mendeteksi kadar debu di debu. Dengan mengetahui spesifikasi secara 

lengkap, pengguna dapat memastikan sensor yang digunakan sesuai dengan 

kebutuhan sistem dan dapat diintegrasikan dengan mikrokontroler secara 

optimal, spesifikasi sensor dapat dilihat pada table 2.5.  

 

Tabel 2. 5 Spesifikasi Sensor debu GP2Y1010AU0F[11] 

No. Spesifikasi Keterangan 

1 Nama Sensor GP2Y1010AU0F 

2 Jenis Sensor Optical Dust Sensor 

3 Tegangan Operasi 5V DC 

4 Tegangan Output 0 – 3.6V (analog) 

5 Konsumsi Arus 20 mA (pengoperasian) 

6 Partikel yang 

Terdeteksi 

Debu dan asap rokok 

7 Waktu Respons kurang dari 1 detik 

8 Suhu Operasional -10°C hingga +65°C 

9 Dimensi 46.0 × 30.0 × 17.6 mm 

10 Komunikasi Output analog dan input LED kontrol 

11 Sudut Deteksi 120 derajat 

12 Fitur Tambahan Menggunakan LED infrared dan 

phototransistor 

 

Setelah membahas spesifikasi sensor debu GP2Y1010AU0F, 

sekarang saatnya memahami pinout sensor tersebut. Mengetahui fungsi dan 
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posisi setiap pin sangat penting agar kita bisa menghubungkan sensor 

dengan mikrokontroler secara tepat. Dengan koneksi yang benar, sensor 

dapat bekerja optimal dan memberikan data yang akurat untuk sistem 

monitoring debu yang kita buat 

 

Gambar 2. 25 Pinout Sensor debu GP2Y1010AU0F 

Pada Gambar 2.25 merupakan pinout dari Sensor GP2Y1010AU0F, 

sensor ini memiliki beberapa pin yang perlu dipahami agar dapat terhubung 

dengan benar. Pin V-LED berfungsi sebagai sumber tegangan untuk LED 

inframerah (IRED) yang digunakan sebagai sumber cahaya, mirip seperti 

memberikan daya pada senter kecil. Pin LED-GND adalah ground untuk 

LED tersebut, seperti jalur negatif pada baterai. Pin LED terhubung ke LED 

dan dapat digunakan untuk mengatur intensitas cahaya yang dipancarkan, 

seperti mengatur tingkat kecerahan senter. S-GND adalah ground untuk 

rangkaian penguat (amplifier circuit) yang memperkuat sinyal dari sensor, 

mirip dengan ground pada amplifier audio. Pin Vo adalah output dari sensor, 

yang menghasilkan tegangan yang sebanding dengan kepadatan debu, 

seperti memberikan informasi tentang seberapa banyak debu yang ada di 

debu. Terakhir, pin Vcc digunakan untuk memberikan tegangan catu daya 

ke rangkaian penguat di dalam sensor, seperti memberikan daya utama ke 

seluruh sensor.  
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Sensor ini memerlukan resistor 150Ω dan kapasitor 220µF untuk 

mendukung pengoperasian pulsa LED. Tegangan output akan terbaca paling 

akurat pada waktu 0.28 ms setelah LED dinyalakan. 

Untuk memastikan kinerja optimal sensor, beberapa panduan 

pemasangan harus diperhatikan[11]: 

1. Hindari masuknya cahaya luar langsung ke area deteksi 

2. Pasang sensor dengan konektor menghadap ke bawah untuk 

mencegah penumpukan debu 

3. Gunakan filter kasar di depan lubang debu untuk menyaring partikel 

besar 

Karakteristik Tambahan yang terdapat pada Sensor GP2Y1010AU0F 

adalah: 

1. Waktu inisialisasi kurang dari 1 detik 

2. Sensor sensitif terhadap getaran dan kondensasi internal 

3. Kalibrasi sensitivitas sudah diatur dari pabrik dan tidak disarankan 

untuk diubah 

4. Sensor dapat terpengaruh oleh gangguan elektromagnetik dari 

perangkat lain 
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GP2Y1010AU0F[11] 
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2.2.7 Motor DC 

Motor DC adalah jenis motor listrik yang memerlukan tegangan arus 

searah untuk menghasilkan gerakan mekanik. Bagian yang menghasilkan 

medan magnet disebut stator (bagian yang diam), sedangkan bagian yang 

berputar disebut rotor (kumparan jangkar).  

 

              

Gambar 2. 27 Motor Dc 

 Gearbox Planetary 12V 110Rpm Aa991 

Pada Gambar 2.27 merupakan motor DC jenis Motor Dc Gearbox 

Planetary 12V 110Rpm Aa991 Perangkat elektronik ini mengubah energi 

listrik menjadi energi mekanik berupa putaran.  

        

Gambar 2. 28 Simbol Motor DC 

Simbol yang ditampilkan pada gambar 2.28 merupakan simbol standar 

untuk motor DC (Direct Current Motor) dalam rangkaian listrik dan 

elektronik. Simbol ini terdiri dari huruf "M" yang menandakan "motor" 
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Gambar 2. 29 Skematik Diagram Motor DC 

Pada Gambar 2.29 rangkaian skematik motor DC, sumber tegangan 

V(t) dihubungkan ke rangkaian armatur yang terdiri dari resistansi R dan 

induktansi L. Arus yang mengalir melalui rangkaian ini akan menghasilkan 

torsi elektromagnetik (τm) yang memutar poros motor. Saat poros berputar, 

kecepatan sudut (ω) yang dihasilkan akan memunculkan tegangan lawan 

(back EMF) yang bekerja melawan tegangan input. Sistem mekanik pada 

motor DC juga melibatkan inersia (J) dan redaman (b), yang mempengaruhi 

respons dinamis motor terhadap perubahan beban atau tegangan masukan. 

Secara keseluruhan, skematik ini menggambarkan hubungan antara aspek 

kelistrikan dan mekanik pada motor DC, sehingga dapat digunakan untuk 

menganalisis performa motor dalam berbagai kondisi operasi, seperti 

perubahan kecepatan, torsi, maupun beban yang diterima. 

Di dalam motor DC, terdapat jangkar dengan satu atau lebih kumparan 

yang terhubung ke komutator (cincin belah) yang berfungsi sebagai saklar 

kutub gPengguna berkat adanya insulator. Prinsip kerja motor DC 

didasarkan pada gaya Lorentz, di mana konduktor berarus dalam medan 

magnet akan menghasilkan gaya yang tegak lurus terhadap arah medan 

magnet dan arus. Motor DC (Direct Current) merupakan salah satu jenis 
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motor listrik yang mengubah energi listrik arus searah menjadi energi 

mekanik berupa gerak rotasi. 

 

 

 

pada gambar 2.28 merupakan Prinsip kerja motor DC didasarkan pada 

hukum Lorentz, yaitu ketika arus listrik dialirkan ke dalam kumparan yang 

berada di antara medan magnet, akan timbul gaya Lorentz yang 

menyebabkan kumparan tersebut berputar. Motor DC terdiri dari beberapa 

komponen utama, seperti stator (bagian diam yang menghasilkan medan 

magnet), rotor atau armature (bagian berputar yang terdiri dari lilitan kawat), 

komutator (cincin belah yang berfungsi membalik arah arus), dan sikat 

(brush) yang menghubungkan arus listrik dari sumber ke kumparan melalui 

komutator. Ketika arus listrik mengalir melalui sikat menuju kumparan 

armature, interaksi antara arus listrik dan medan magnet menghasilkan gaya 

Lorentz yang mendorong armature untuk berputar. Komutator berperan 

penting dalam membalik arah arus setiap setengah putaran sehingga torsi 

yang dihasilkan tetap searah dan rotor dapat berputar secara kontinu. 

Dengan demikian, selama arus listrik mengalir ke motor, proses konversi 

energi listrik menjadi energi mekanik akan terus berlangsung dan motor 

akan tetap berputar. 

Adapun dalam alat pembersih panel surya otomatis ini menggunakan 

motor DC motor DC 25-ga-370 rs-370 dengan spesifikasi pada table 2.6. 

 

       Gambar 2. 30 Gaya lorentz 
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Tabel 2. 6 Spesifikasi Motor DC Gearbox Planetary AA991 

Spesifikasi Keterangan 

Nama Produk Motor DC Gearbox Planetary AA991 

Tegangan Operasional 12 Volt DC 

Kecepatan Tanpa Beban ±110 RPM 

Jenis Gearbox Planetary Gearbox 

Rasio Gearbox ±1:30 – 1:50 (tergantung varian) 

Torsi Maksimal ±20 – 25 kg.cm 

Diameter Poros Output ±8 mm 

Panjang Poros ±20 mm 

Diameter Motor ±36 mm 

Panjang Total Motor ±90 – 100 mm 

Arus Tanpa Beban ±0.4 – 0.7 A 

 

2.2.8  Pompa 

 Pompa adalah perangkat yang berfungsi mengubah energi mekanis 

menjadi energi hidrolik. Secara umum, pompa digunakan untuk 

memindahkan cairan dari satu lokasi ke lokasi lain dengan cara 

meningkatkan tekanan cairan tersebut serta memberikan energi kepada 

fluida yang dipompa, pompa ditunjukan pada gambar 2.29.[12] 
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Gambar 2. 31 Pompa Dispenser Miyako 

 Pompa bekerja berdasarkan prinsip menciptakan tekanan rendah di 

bagian isap (suction) sehingga cairan dapat tersedot masuk, kemudian 

mengeluarkannya pada sisi tekan (discharge) dengan tekanan yang lebih 

tinggi. 

 

 

 

 

Gambar 2. 32 Penampang Impeller dan perubahan energi 

pompa[12] 

Gambar 2. 33 Proses Pemompaan 
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Pada pompa terdapat bilah-bilah impeller yang berfungsi 

mengangkut cairan dari posisi yang lebih rendah ke posisi yang lebih tinggi. 

Impeller dipasang pada poros pompa yang terhubung dengan motor 

penggerak, biasanya berupa motor bakar atau motor listrik. Ketika motor 

penggerak berputar, poros pompa akan ikut berputar dan memutar impeller. 

Gerakan putar impeller menyebabkan cairan di dalamnya ikut berputar, 

sehingga tekanan dan kecepatan cairan meningkat. Cairan kemudian 

terdorong dari pusat pompa menuju saluran berbentuk volute atau spiral, lalu 

keluar melalui nosel. 

Dengan demikian, fungsi impeller pada pompa adalah mengubah 

energi mekanik dari putaran impeller menjadi energi fluida pada cairan. 

Cairan yang masuk ke dalam pompa akan memperoleh tambahan energi, 

yang menyebabkan peningkatan head tekan, head kecepatan, dan head 

potensial. Ketiga jenis head ini jika dijumlahkan disebut sebagai head total. 

Head total pompa juga dapat diartikan sebagai selisih energi per satuan berat 

cairan antara sisi hisap dan sisi tekan pompa. 

 

Gambar 2. 34 Skematik Diagram Pompa Air 

Diagram kelistrikan pompa air pada Gambar 2.34 menggambarkan 

susunan komponen utama yang digunakan untuk mengoperasikan pompa air 

listrik satu fasa pada tegangan 220V. Sumber listrik dihubungkan ke sistem 

melalui kabel cokelat dan biru, dengan kabel biru melewati pressure switch 

yang berfungsi sebagai saklar otomatis berdasarkan tekanan air. Setelah 
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pressure switch, arus listrik dialirkan ke kapasitor yang berfungsi membantu 

proses starting motor dengan memberikan torsi awal pada kumparan bantu. 

Pada jalur kabel cokelat, terdapat thermal protector yang akan 

memutus arus jika suhu motor melebihi batas maksimum 130°C, sehingga 

melindungi motor dari kerusakan akibat overheat. Dari thermal protector, 

arus masuk ke kumparan utama motor, sementara jalur lain melalui 

kapasitor menuju kumparan bantu. Kedua kumparan ini bekerja sama untuk 

menghasilkan medan magnet yang memutar rotor motor pompa air. 

Diagram ini juga menunjukkan adanya sistem grounding yang 

terhubung ke body pompa guna mencegah bahaya listrik akibat kebocoran 

arus. Dengan konfigurasi ini, pompa air dapat bekerja secara otomatis dan 

aman, serta terlindungi dari risiko panas berlebih dan gangguan kelistrikan 

lainny 

Untuk mendukung proses penyemprotan air pada permukaan panel 

surya, dibutuhkan pompa yang praktis, bertenaga cukup, dan mudah 

dikendalikan. Oleh karena itu, digunakan pompa Dinamo Dispenser Miyako 

WDP-200/WDP-300 12V DC, Adapun spesifikasi pompa tersebut terdapat 

pada tabel 2.7.  

Tabel 2. 7 pompa Dinamo Dispenser Miyako WDP-200/WDP-300 12V 

DC[12] 

Spesifikasi Keterangan 

Tipe Pompa Pompa air mini DC untuk dispenser galon 

bawah 

Tegangan Kerja 12V DC 

Debit Air ± 2 liter/menit 

Fitur keamanan Smart Safety Pump, Smart Indicator 

Kapasitas Tangki 1,9 liter (cadangan air tetap tersedia saat listrik 

mati) 

Material Food grade, sesuai stPenggunar SNI 
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Aplikasi Menyedot air dari galon bawah ke tangki 

dispenser 

Daya Listrik (Total 

Unit) 

350–420 watt (termasuk pemanas & pendingin) 

Tipe Instalasi Terintegrasi di dalam unit dispenser 

      

2.2.9 Wiper pembersih  

Wiper adalah perangkat yang digunakan untuk membersihkan atau 

menghapus air, kotoran, dan debu dari permukaan kaca. Wiper umumnya 

digunakan pada kendaraan bermobil untuk memastikan visibilitas yang baik 

saat mengemudi, terutama dalam kondisi cuaca buruk seperti hujan, salju 

atau embun beku.[2] 

               

Gambar 2. 35 Wiper 

Wiper bekerja dengan gerakan berulang-ulang melintasi permukaan 

kaca untuk membersihkan kotoran, Jenis-jenis karet Wiper meliputi: 

a. Silicon Squeegee StPenggunar (Single Blade) 

Wiper Jenis ini merupakan squeegee paling sederhana, terdiri dari 

satu bilah karet atau silikon yang digunakan untuk menghapus air 

dan kotoran dari permukaan kaca. Squeegee stPenggunar biasanya 

memiliki gagang pendek dan mudah digunakan untuk membersihkan 

kaca jendela, cermin, atau permukaan datar lainnya di rumah. 
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b. Squeegee Multifungsi (2 in 1 atau Multifungsi) 

Wiper ini menggabungkan dua atau lebih fungsi dalam satu alat, 

misalnya satu sisi berupa bilah karet untuk menyeka air dan sisi 

lainnya berupa spons atau kain microfiber untuk mengangkat 

kotoran. Beberapa tipe juga dilengkapi gagang yang bisa 

dipanjangkan (extendable handle) atau semprotan cairan pembersih 

(built-in spray). Jenis ini cocok untuk membersihkan kaca di area 

yang sulit dijangkau atau untuk membersihkan permukaan lain 

seperti lantai dan keramik. 

c. Squeegee Magnetik 

wiper terdiri dari dua bagian yang saling menempel melalui kaca 

dengan bantuan magnet. Alat ini memungkinkan pembersihan kedua 

sisi kaca secara bersamaan, sangat efektif untuk jendela yang sulit 

dijangkau dari luar, seperti pada gedung bertingkat atau apartemen. 

Squeegee magnetik biasanya digunakan untuk kaca dengan 

ketebalan tertentu agar magnet dapat bekerja optimal. 

Wiper squeegee stPenggunar dipilih karena ringan, sederhana, dan 

cukup efektif menyapu debu pada permukaan panel surya berukuran 

kecil. Jenis single blade mempermudah gerakan bolak-balik 

menggunakan motor DC dan tidak membebani rangka. Selain itu, 

bentuknya cocok dengan sistem rel dan posisi semprotan air, 

sehingga pembersihan lebih merata tanpa komponen tambahan yang 

kompleks. 

 

2.2.10 Limit Switch  

Limit switch merupakan salah satu jenis sensor mekanis yang 

berfungsi untuk mendeteksi posisi atau batas gerakan suatu objek dalam 

sistem otomasi. [1] 
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Gambar 2. 36 Limit Switch 

Prinsip kerja limit switch didasarkan pada kontak fisik antara 

aktuator (seperti tuas, roller, atau plunger) dengan objek yang bergerak. 

Ketika objek menyentuh aktuator, terjadi perubahan posisi pada kontak 

internal di dalam limit switch, sehingga menghasilkan perubahan status 

sinyal listrik pada terminal Normally Open (NO) atau Normally Closed 

(NC). Sinyal ini kemudian dapat digunakan oleh sistem kontrol, seperti 

mikrokontroler atau PLC, untuk memberikan perintah tertentu, misalnya 

menghentikan mesin, mengubah arah gerak, atau sebagai sistem pengaman. 

 

 

Gambar 2. 37 Prinsip kerja limit Switch 

 

Gambar 2.37 menunjukkan prinsip kerja limit switch dengan tipe 

tuas dan roller. Pada bagian kiri gambar, terlihat ada tiga terminal utama, 

yaitu COM (common), NC (normally closed), dan NO (normally open). Di 

bawah terminal, terdapat tuas (lever) yang ujungnya dilengkapi dengan 
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roller tip. Ketika tuas ini ditekan ke atas oleh suatu objek, mekanisme di 

dalam limit switch akan berubah. Dalam keadaan normal (tuas tidak 

ditekan), terminal COM terhubung dengan NC sehingga arus listrik dapat 

mengalir melalui jalur ini. Namun, saat tuas ditekan ke atas, koneksi 

berpindah dari NC ke NO, sehingga arus listrik sekarang mengalir dari COM 

ke NO. Gambar di sebelah kanan memperlihatkan skema rangkaian yang 

setara, di mana posisi kontak akan berubah tergantung apakah tuas ditekan 

atau tidak. Dengan cara kerja seperti ini, limit switch dapat digunakan untuk 

mendeteksi posisi atau batas akhir gerakan suatu mesin secara otomatis dan 

memberikan sinyal ke sistem kontrol. 

Pada sistem alat pembersih panel surya otomatis ini digunakan 

komponen limit switch sebagai sensor pendeteksi posisi mekanis. Limit 

switch ini berfungsi untuk memberikan sinyal ketika wiper mencapai batas 

ujung lintasannya. Pemilihan komponen ini didasarkan pada 

kemampuannya yang Penggunal dalam kondisi lingkungan yang bervariasi 

serta kemudahan integrasi dengan rangkaian mikrokontroler. Adapun detail 

spesifikasi teknis dari limit switch yang digunakan dapat dilihat pada Tabel  

            2.8.  

Tabel 2. 8 Spesifikasi Limit Switch 

No. Parameter Spesifikasi 

1 Dimensi Bodi 28 mm x 16 mm x 10 mm 

2 Panjang Gagang 27 mm 

3 Tegangan & Arus 5A/250V, 16A/125V 

4 Rating 15A 250VAC / 0.6A 125VDC / 0.3A 

250VDC 

5 Bentuk Kontak SPDT (Single Pole Double Throw) 

6 Tipe Kontak Momentary, material kontak: Silver, 

tuas: Stainless Steel 

7 Jenis Aktuator Tuas Engsel dan Roda 

8 Jenis Terminal Quick Connect 
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9 Jumlah Terminal 3 (NC, NO, dan COM) 

10 Gaya Operasi Maksimum 1.23 N 

11 Suhu Kerja -25°C hingga 80°C 

12 Dimensi Keseluruhan 37 mm x 30 mm x 10 mm 

 

2.2.11 ThingSpeak Server 

ThingSpeak adalah sebuah platform Internet of Things (IoT) 

berbasis cloud yang digunakan untuk menyimpan dan memantau data sensor 

secara real-time melalui jaringan internet. [13] 

 

Gambar 2. 38 ThingSpeak 

Pada Gambar 2.38 merupakan Platform ThingSpeak, platform 

ThingSpeak ini memudahkan pengguna dalam mengirimkan data dari 

perangkat mikrokontroler seperti ESP32 ke server online, kemudian 

menampilkannya dalam bentuk grafik yang mudah dipahami. ThingSpeak 

juga mendukung analisis data langsung di dalam platform menggunakan 

MATLAB, sehingga proses pemantauan dan evaluasi bisa dilakukan secara 

praktis dan efisien. 

Di dalam ThingSpeak terdapat beberapa komponen penting, seperti 

channel sebagai tempat penyimpanan data, field untuk setiap jenis data 

sensor, serta API key yang berfungsi sebagai akses pengiriman dan 

pengambilan data. Selain itu, pengguna juga disediakan dashboard untuk 

memvisualisasikan data dalam bentuk grafik waktu nyata, yang bisa diakses 

dari perangkat mana pun selama terhubung ke internet. 

Dalam merancang dan membangun alat pembersih panel surya 

otomatis ini, pemilihan platform ThingSpeak didasarkan pada kebutuhan 
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sistem untuk dapat melakukan pemantauan data secara real-time dan 

berbasis internet. ThingSpeak memungkinkan data dari alat seperti jam 

operasional, intensitas debu PM2.5, status pembersihan, hingga jumlah 

siklus kerja untuk dikirim dan ditampilkan secara langsung dalam bentuk 

grafik yang mudah dipahami. 

Platform ini dipilih karena mampu berkomunikasi langsung dengan 

ESP32 melalui koneksi WiFi, serta menyediakan dokumentasi API yang 

sederhana, sehingga proses integrasi tidak memerlukan konfigurasi 

kompleks. ThingSpeak juga memiliki kelebihan dalam menyimpan data 

historis, sehingga pengguna atau peneliti dapat meninjau dan mengevaluasi 

performa alat secara berkala.[12] 

Selain itu, ThingSpeak mendukung visualisasi interaktif yang 

membuat data tidak hanya ditampilkan sebagai angka, tetapi juga dalam 

bentuk grafik yang dinamis dan informatif. Hal ini sangat membantu dalam 

melakukan analisis sederhana terhadap kondisi lingkungan dan efektivitas 

kerja alat. 

Setelah memahami penjelasan umum tentang ThingSpeak sebagai 

platform cloud untuk Internet of Things (IoT), langkah berikutnya adalah 

mempelajari cara penggunaannya secara praktis. ThingSpeak menyediakan 

kemudahan bagi pengguna untuk mengirim, menyimpan, dan memantau 

data sensor secara real-time melalui internet. Dengan fitur seperti visualisasi 

data dalam bentuk grafik, akses cloud dari mana saja, serta integrasi dengan 

perangkat, platform ini sangat cocok digunakan baik untuk pemula maupun 

pengembang proyek IoT yang lebih kompleks. 

Sebagai langkah awal dalam menggunakan ThingSpeak, pengguna 

perlu membuat akun terlebih dahulu, seperti yang ditunjukkan pada gambar 

2.35. Jika sudah memiliki akun, pengguna bisa langsung melakukan login. 

Namun, bagi yang belum memiliki akun, harus membuatnya terlebih dahulu 

dengan mendaftarkan email yang bersifat akun resmi. Proses pendaftaran ini 

meliputi pengisian data seperti nama, alamat email, lokasi, dan verifikasi 

melalui email yang dikirimkan oleh ThingSpeak. Setelah email terverifikasi 
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dan pembuatan password selesai, akun siap digunakan untuk mengakses 

platform ThingSpeak dan melanjutkan ke tahap berikutnya.  

 

 

Gambar 2. 39 Pembuatan Akun ThinkSpeak 

. Setiap channel dapat diatur sesuai kebutuhan, mulai dari pemberian 

nama, penambahan field untuk data sensor, hingga pengaturan privasi data. 

Setelah channel dibuat, ThingSpeak akan memberikan API Key yang 

berfungsi sebagai kunci agar perangkat IoT dapat mengirimkan data ke 

platform ini. Selanjutnya, pengguna dapat mulai menghubungkan perangkat 

seperti Arduino atau ESP32 ke ThingSpeak dengan memasukkan API Key 

dan konfigurasi jaringan ke dalam kode program. Dengan demikian, data 

sensor yang diperoleh dari perangkat akan secara otomatis tampil dan dapat 

dipantau melalui dashboard ThingSpeak 

Setelah berhasil login ke akun ThingSpeak, langkah berikutnya 

adalah mengakses menu “Channels” yang terletak di bagian atas halaman 

utama seperti pada gambar 2.39. Dari menu tersebut, pilih opsi “My 

Channels” untuk melihat daftar channel yang sudah dibuat atau untuk 

memulai pembuatan channel baru. Untuk membuat channel baru, klik 

tombol “New Channel” yang akan membawa Pengguna halaman pembuatan 

channel, di mana Pengguna dapat mengatur nama channel, deskripsi, serta 

menambahkan field untuk data sensor yang akan dikirimkan. Proses ini 
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merupakan tahap awal yang penting agar data dari perangkat IoT dapat 

tersimpan dan dipantau secara terstruktur di platform ThingSpeak. 

 

Gambar 2. 40 Pembuatan Channel ThingSpeak 

Pada Gambar 2.40, saat membuat channel baru di ThingSpeak, 

pengguna perlu mengisi beberapa informasi penting agar channel tersebut 

dapat berfungsi dengan baik dan data yang dikirimkan dari sensor dapat 

tersimpan secara terstruktur. Pertama, berikan nama channel yang jelas dan 

deskriptif, misalnya “MONITORING PEMBERSIH PANEL SURYA,” 

agar mudah dikenali dan sesuai dengan fungsi channel tersebut. Selanjutnya, 

isi deskripsi singkat yang menjelaskan tujuan pembuatan channel, seperti 

“Hal yang dimonitor adalah intensitas debu, waktu mulai pembersihan, 

waktu pembersihan selesai, dan urutan laporan.” Selain itu, pengguna juga 

harus menentukan nama-nama field yang mewakili data yang akan 

dikumpulkan, misalnya “Jadwal” untuk penjadwalan rutin dan “pm2.5” 

untuk tingkat debu. ThingSpeak menyediakan hingga delapan field dalam 

satu channel, sehingga pengguna dapat menyesuaikan nama field sesuai 

dengan jenis data sensor yang digunakan. Setelah semua informasi terisi 

dengan lengkap, channel siap digunakan untuk menerima dan menyimpan 

data dari perangkat IoT, sehingga memudahkan pemantauan data secara 

real-time melalui platform ThingSpeak. Dengan pengaturan ini, proses 
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monitoring sistem pembersih panel surya dapat berjalan lebih efektif dan 

terorganisir. 

 

Gambar 2. 41 Channel baru di ThinkSpeak 

Untuk memulai penggunaan ESP32 di Arduino IDE, langkah 

pertama yang perlu dilakukan adalah mengatur board ESP32 pada Arduino 

IDE. Caranya, buka Arduino IDE lalu masuk ke menu File > Preferences, 

kemudian pada kolom “Additional Board Manager URLs” tambahkan 

alamat https://dl.espressif.com/dl/package_esp32_index.json. 

Setelah itu, buka Tools > Board > Boards Manager, cari “ESP32”, 

dan klik Install pada versi terbaru yang tersedia. Setelah proses instalasi 

selesai, pilih board ESP32 yang sesuai “ESP32 Dev Module”, lalu 

hubungkan board ke komputer menggunakan kabel USB. 

Selanjutnya, Pengguna perlu menginstal library yang dibutuhkan 

untuk ESP32 dan ThingSpeak agar dapat digunakan dalam pemrograman. 

Caranya dengan membuka menu Sketch > Include Library > Manage 

Libraries di Arduino IDE, kemudian cari dan instal library “ESP32” dan 

“ThingSpeak”. 

Setelah semua pengaturan dan instalasi library selesai, langkah 

berikutnya adalah mengembangkan sketch Arduino untuk ESP32.seperti 

pada gambar 2.41, Pengguna perlu mengimpor library yang diperlukan 

seperti WiFi.h untuk menghubungkan ESP32 ke jaringan Wi-Fi dan 

ThingSpeak.h untuk mengirim data ke platform ThingSpeak. Jangan lupa 

untuk memasukkan kredensial Wi-Fi Pengguna, yaitu nama jaringan (SSID) 

dan password, agar ESP32 dapat terhubung ke internet dengan lancar. 



56 
 

 

 

 

 

Gambar 2. 42 Sketch Arduino IDE untuk ThingSpeak terhubung ke 

ESP32 

Dalam sketch Arduino yang dibuat, library ThingSpeak digunakan 

untuk menghubungkan ESP32 dengan channel yang telah dibuat sebelumnya. 

Pada kode program, API key yang diberikan oleh ThingSpeak dimasukkan 

sebagai identitas agar perangkat dapat mengirim data ke channel yang tepat. 

Dengan cara ini, data sensor yang dikumpulkan oleh ESP32 dapat langsung 

tersimpan dan dipantau secara real-time melalui platform ThingSpeak, 

sehingga memudahkan proses monitoring dalam sistem yang dikembangkan, 

seperti pada gambar 2.39.  

 

Gambar 2. 43API key ThingSpeak 

Setelah masuk kembali ke akun ThingSpeak, langkah selanjutnya 

adalah membuka halaman channel yang telah dibuat. Pada halaman tersebut, 

pengguna dapat mengakses tab “Apps” dan memilih “ThingView” untuk 

melihat visualisasi data secara default yang telah disediakan oleh platform. 
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Jika ingin membuat visualisasi yang lebih sesuai dengan kebutuhan atau 

tampilan yang lebih personal, pengguna dapat kembali ke tab “Apps” dan 

menjelajahi berbagai pilihan visualisasi yang tersedia di ThingSpeak. Dengan 

fitur ini, proses pemantauan data menjadi lebih mudah dan informatif,  

 

 

Gambar 2. 44 Visualisasi thingSpeak 

 

 

 

 

 

 

 

 


